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1 Basic Information

KYOCERA Net Manager System Documentation

KYOCERA Net Manager
New Features Guide

Provides an overview of the new features
available in KYOCERA Net Manager.

KYOCERA Net Manager
Admin Guide

Describes administration and configuration
features such as accounting, cloud licensing,
remote terminal management, upgrade, server
backup, uninstallation.

KYOCERA Net Manager
Embedded Terminal
Guide

Describes the installation and configuration of
the KYOCERA Net Manager Embedded
Terminal and use of Terminal Manager.

KYOCERA Net Manager
Installation Guide

Provides instructions for installing software and
initial configuration, searching printing devices,
adding users, creating print queues, assigning
terminals to printing devices, and setting up
printer drivers.

KYOCERA Net Manager
User Guide

Describes the KYOCERA Net Manager web
interface and the KYOCERA Net Manager
Embedded Terminal.

What is KYOCERA Net Manager?
KYOCERA Net Manager is a server-based web application that manages your
print devices and user policies to provide secure printing and copying and to
provide accounting of print-related expenses. Efficient use of your printing
resources is provided by the Print&Follow function which allows users to
securely print to any printer managed by KYOCERA Net Manager.
KYOCERA Net Manager offers many advantages:

• Authentication - Access the devices in one step by PIN, ID card or
name/password or in a two-step authentication combination such as ID-Card
and PIN

• Security - Secure printing, data encryption and the Print&Follow function
ensure that your documents can only be accessed and printed by authorized
people

• Reporting - KYOCERA Net Manager keeps detailed statistics about all
aspects of printing and printers, scanning and copying, projects, accounting
and users and groups

• Personalized Features - KYOCERA Net Manager allows IT administrators
to show different functions and applications per user based on the user’s
requirements
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• Easy Scan - One click changes the destination of your scanned documents
and their meta data. You may choose between your home folder, fax server,
or email address

• Mobile printing - Print documents from your mobile device by sending the
job to the KYOCERA Net Manager server
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2 Web Interface

The KYOCERA Net Manager user interface can be displayed in one of the
supported web browsers: Google Chrome, Internet Explorer, Microsoft Edge,
and Mozilla Firefox. Contact your system administrator for the KNM web
address and your credentials if you have not received them.

Starting Net Manager Web Administrator
Click Start > Kyocera > Kyocera Net Manager Web Administrator to open
the login screen.

Before logging in to the system, select a language from the drop down menu.
Type your User name and Password / PIN and click Login.
When you first log in to the system, use the password issued by your system
administrator.
User access can also be established through the domain policy of your network.
In this case, you would use your network login credentials.

Net Manager User Interface
The user interface of the application is displayed after the user logs in
successfully. The default view is the Home tab with current user and job info
displayed. Users click the KYOCERA menu for additional options, or can use
the Quick Links.
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Home Tab
The Home tab shows the number of paused jobs, favorite jobs, and jobs ready
to be printed.
With the credit system activated, you are informed of the current account
balance and have an option to display your credit history. If quotas for users or
departments are enabled, you are shown the current limits for your individual
quota.
If enabled, you may edit your user profile and generate a new PIN for your
account.

Note: Credit and quotas may not be available for all systems.
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Recharging Credit
You can add credit to your account by entering a voucher number, through
PayPal (if configured), or an administrator can recharge credit for users or
groups.

1 Click Recharge Credit.

2 Enter a voucher number (or a recharge amount for PayPal) and click Recharge
Credit on the recharge screen.
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The system pops up an OK confirmation, your account is increased by the value
of the voucher or amount requested through PayPal, and the new Account
balance is displayed.
When using the Embedded Terminal, the voucher may be entered on the touch
panel. (PayPal not available through Embedded Terminal.)

Changing your PIN
You may change your Personal Identification Number (PIN).

1 Click Generate PIN.

2 Click OK to confirm.

3 Record your new PIN and click OK.

If configured by the Admin, your new PIN is also sent to your email address.
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Jobs
In the Jobs tab, you can monitor print jobs in various stages of processing.

• The Ready folder shows all jobs waiting to be printed
• All paused jobs can be displayed by clicking on the Paused folder
• If a job is printed, it is automatically moved to the Printed folder
• The jobs marked as favorites are included in Favorite
• A record of deleted jobs is displayed in the Deleted folder
• A complete overview of all print jobs can be found in the All folder

Note: If Job Roaming is enabled, there will also be a Job roaming folder.

Changing the Job Owner

The job owner can be changed only if you have sufficient rights. The system
administrator can move print jobs between users, and to heads of user groups.
Heads of user groups can move jobs between users in the group.

1 Double-click a job to open the General information screen.

2 Click the Owner drop-down menu and select a new owner.

3 Click Save.
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If the selected owner has no rights to print from the print queue to which the
print job is assigned, the change of owner is not possible, and an error message
appears.

Changing the Assigned Print Queue

The print queue can be changed only if you have sufficient rights.

1 Double-click a job to open the General information screen.

2 Click the Queue drop-down menu and select a new queue.

3 Click Save.
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If the current owner has no rights to the new print queue, the change of the print
queue is not possible, and an error message appears.

Changing the Assigned Project

The print project can be changed only if you have sufficient rights, including
rights to the new project.

1 Double-click a job to open the General information screen.

2 Click the Project drop-down menu and select a new project.

3 Click Save.
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Reports
By default, User Counter reports are available to all users.
KNM has a large number of statistical reporting available through the web
interface. The KNM Administrator can grant rights to users and groups for any
built in or customized reports. A user must have the Manage reports right in
order to run shared reports.

Running Reports

1 Access reports by clicking the KYOCERA menu, then Reports.

2 Select a report from the list and set parameters, including format (choices are
PDF, CSV, and HTML.)

3 Click Run.

Note: You can also Schedule a report to run later or at on a set schedule, or
Save a report to run with the configured parameters pre-set in the future.
Saved reports will be listed on the Saved reports tab.
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A table with statistics is displayed. For PDF, there's a PDF tool bar immediately
above it. For all output types the report toolbar has options for scheduling future
runs and exporting to a variety of formats: PDF, CSV, HTML, XML, XLS, XLSX,
and ODS.

Saving a Generated Report

After generating a report, you can save it in different formats (PDF, CSV, HTML,
XML, XLS, XLSX, and ODS).

1 Click the associated icon on the report toolbar.

The system prompts you to save the file or view it in the associated application.

2 Click Save File then set the location, Filename and Save as type for the report.

The file save window displays options for the location, filename, and format for
the report.

3 Follow system prompts for saving or viewing the file.
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3 Working with Embedded
Terminal

KNM Embedded Terminal supports display and control of printing device
functions directly from the control panel of the device. Users can release jobs
held in KNM Print&Follow, Delegated or other queues. They can also use
scan, print, FAX and copy functions (depending on the capabilities of the
device) directly on the device from the Embedded Terminal.

Logging on to Embedded Terminal
The two most common ways to log on to Embedded Terminal are by tapping an
ID card on the card reader (on devices equipped with readers) or by entering a
PIN on the terminal and tapping OK.
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The KNM Administrator configures log in requirements for Embedded Terminal.
Log in can be through any combination of:

• ID Card
• PIN
• Username and Password

Embedded Terminal Panel Screen
The appearance of the user interface of the Embedded Terminal panel is
established by the system administrator. KNM supports a maximum of 10
buttons on the panel. Functionality can be expanded by creating folders and
subfolders for additional buttons.

Logging Out of Embedded Terminal
To end an Embedded Terminal session, you may tap the logout button on the
panel (upper right corner), tap your card on the reader again, or press the hard
logout button on the keypad. If you do none of these, the terminal will
automatically log you off after a preset interval.
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Logout panel button

Keypad logout button

Two-factor Authentication
If a higher level of security is necessary, the KNM administrator may require
users to authenticate using two elements, such as ID Card and PIN/Password.
Tap your ID card on the reader and then enter your PIN or password at the
terminal keypad.
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4 Types of Printing

In addition to standard Direct Print, printing devices managed by KNM and
equipped with an authentication mechanism (Embedded Terminal, Embedded
Lite, an ID card reader, etc.) can use secure/delayed print (Print&Follow), and
secure copy/ptint.

How to use Direct Print
Select Print in the menu of the application then select the printing device
connected to the direct queue of the KYOCERA Net Manager system. The
document is immediately sent to the printer.
Do not use direct print for confidential documents if the printer is not secured
from unauthorized access.

Secure / Delayed Print (Print&Follow)
The print job sent to the secure (Print&Follow) queue is not printed
immediately, but it is stored on the KNM server. When the job owner logs onto
the device, the panel is unlocked and their print job is completed. If the KNM
Admin has enabled it, all other active print jobs in queue are printed. If not, the
user can manually release print jobs after logon.

Secure Copying
By default, the panel of the printing device is locked. When a user logs in, the
system verifies access rights. After successful authentication, the panel is
unlocked and the user can use the device for copying and other tasks. After
finishing the work, the user logs out, or is logged out automatically after a
specified period of time.
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5 Common Tasks

Printing

Direct Print
A job sent to the direct queue is processed by the system and sent immediately
to the appropriate printing device. After the job is printed, the number of pages
used in the job is charged to the user’s account if credit accounting is enabled.
Direct print is used only for controlling the print volume and does not support
any advanced functions. Direct print does not require logging on to the terminal.

How to Print a Document using the Print&Follow Queue
With Print&Follow the document is immediately sent to the Print&Follow
queue of the KNM server. When the job owner logs onto the device terminal the
panel is unlocked and their job can be printed.

Print Jobs
Log in to the KNM web interface to perform the following Print job tasks.

Deleting a Print Job
To delete a print job that has been already sent to the Net Manager server:

1 Click Jobs (from the Home tab or the KYOCERA menu.)

2 Select a job from the appropriate folder (Ready, Paused, or Printed.)

3 Click Actions, then Delete.

4 Confirm the deletion.
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The record of the job is moved to the Deleted folder.

Marking Print Jobs as Favorite
When a print job is printed frequently (e.g. printing of standardized forms), it is
useful to mark the print job as a Favorite. It is moved to the Favorite folder
where it can be pushed again to print queue at any time. Favorite jobs are not
deleted by the system.

1 Click Jobs (from the Home tab or the KYOCERA menu.)

2 Select a job from the appropriate folder (Ready, Paused, or Printed.)

3 Click Actions, then Favorite.

The Favorite flag is added to the print job.

To remove the Favorite flag, select a favorite job, and click Actions >
Favorites again.

Pausing a Print Job

1 Click Jobs (from the Home tab or the KYOCERA menu.)

2 Select a job from the Ready folder.



Common Tasks

KYOCERA Net Manager 5-3

3 Click Actions, then Pause.

The job is moved to the Paused folder.

Pushing a Job to the Print Queue
All the print jobs that have not yet been deleted by the Net Manager system can
be pushed again to the print queue. This feature can be used for favorite and
paused print jobs.

1 Click Jobs (from the Home tab or the KYOCERA menu.)

2 Select a job from the appropriate folder (Paused, Printed, Favorite, or All.)

3 Click Actions, then Push to print queue.

The status is automatically changed to Ready and the job is moved to the
Ready folder. Depending on the type of selected queue, the document is
immediately sent to the printing device or waits until you logon to the selected
printing device.

Job Roaming
With the Job Roaming feature configured, jobs sent to the Print&Follow queue
on any site server can be displayed in two places:

• KNM Web UI
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• Embedded terminal of any printing device attached to the Job Roaming
queue

You can download the jobs to the Job Roaming queue to be printed on any
printing device that is attached to it.

Downloading Job Roaming Jobs on the KNM Web UI

1 Log on your account on the KNM web UI.

2 Click the KYOCERA icon, then Jobs.

The Jobs main tab opens.

3 On the left side of the tab, under My jobs, click Job roaming.

The Job roaming tab opens.

4 On the tab, select the jobs to be downloaded, and then click Download.

The jobs are downloaded to the Job roaming queue and can be printed on any
printing device attached to that queue.

Projects

How to Print using Project Accounting
With Projects enabled, the KNM Easy Job Manager icon is visible in the
taskbar for all users.

Double-click the icon to open Easy Job Manager. It shows a list of jobs that
have not been assigned to any projects yet. With Projects enabled, you cannot
print jobs that are not assigned to a project or confirmed to print without a
project (if enabled).
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The top right of the screen shows the following:

• The user name and KNM server IP address
• A refresh button
• Launch KNM button to open the KNM Web UI
• Language selection drop-down menu

A list of user projects is displayed on the left side and another list of jobs not yet
assigned to any projects is shown on the right side.
The Search box on the left lets you search for projects by name.

In the Job list, click the Job Name box to select all jobs or click check boxes by
individual jobs.
To assign a job to a project and send it to print, check the box by the job name,
click the name of the project, and click Print.
Click Delete to delete the selected jobs from the list.

After successfully assigning a job to a project, an information box appears at the
toolbar panel.
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How to Print with Projects and Direct Queue
To use projects for direct queue, you must have Easy Job Manager installed.
The application is activated after installation and stays minimized in the
Windows taskbar. A pop-up window is shown after a file is sent for printing.

You can select a project in this window and click Print. For direct queue, the
jobs are printed immediately. Print&Follow queue jobs are transferred to the
KNM server.

KYOCERA Mobile Print integration
Mobile printing can be managed by KYOCERA Net Manager. This allows
policies, quotas, and credits to be applied to mobile device users.
KYOCERA Mobile Print can support Direct Print and Print&Follow printing
based on the print queue that is selected by the user.

Note: Windows authentication is not supported in KYOCERA Mobile Print,
which means that iOS or Android mobile device users will need to manually
enter their username and password into their mobile devices.

Note: If you are unable to log in to the KYOCERA Net Manager server when
using KYOCERA Mobile Print, check that the login method selected is Net
Manager, and that User login and Job Accounting are disabled.

The mobile user interface for printing and scanning is different on iOS and
Android devices. See the following for instructions for each OS.

Printing Documents on Android devices

1 Open the KYOCERA Mobile Print application.

2 Select a document source (Documents, Photos, Camera, Clipboard, Web,
Dropbox, Evernote, OneDrive, QR Code.)

3 Select a document.

4 Open the Settings menu and select Net Manager.

5 Configure the KYOCERA Net Manager settings:

• Server - Enter the IP address or hostname of the KYOCERA Net Manager
server
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• Port - Enter 9094
• User name - Enter your KYOCERA Net Manager user name
• Password - Enter your KYOCERA Net Manager password (not PIN, talk to

your KNM Admin if you don’t have a password)
• Select IPP or IPPS

6 Tap OK. Back on the Settings screen, the Net Manager slider icon to set to On.

7 Tap Back to return to your document preview.

8 Optional – Tap Printing preferences and made adjustments as needed.

9 Tap Select queue, and tap a queue name to select it.

10 Tap Print.

Scanning Documents on Android devices

1 Open the KYOCERA Mobile Print application.

2 Select Scan.

3 Tap Select device at the bottom of the screen.

4 Choose a scanning device to use from the following:

• Favorites
• Recent
• Discover
• Input IP address
• Scan QR code with the mobile device camera

5 Tap a device to select it.

6 Open the Settings menu and select Net Manager.

7 Configure KYOCERA Net Manager settings:

• Server - Enter the IP address or hostname of the KYOCERA Net Manager
server

• Port - Enter 9094
• User name - Enter your KYOCERA Net Manager user name
• Password - Enter your KYOCERA Net Manager password (not PIN, talk to

your KNM Admin if you don’t have a password)
• Select IPP or IPPS

8 Tap OK. Back on the Settings screen, the Net Manager slider icon to set to On.
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9 Tap Back to return to the scanning screen.

10 Optional - Set scanning preferences.

11 Place document to be scanned on the scanner and tap Scan.

12 Tap Save to save a copy of your scan to the Documents folder. File format
choices (in Scanning preferences) are PDF, JPEG and TIFF.

Printing Documents on iOS devices

1 Open the KYOCERA Mobile Print application.

2 Select a document source. (Documents, Photos, Camera, Clipboard, Web,
Dropbox, Evernote, OneDrive, Shared Folder, QR Code.)

3 Select a document.

4 Configure KYOCERA Net Manager settings:

• Server - Enter the IP address or hostname of the KYOCERA Net Manager
server

• Port - Enter 9094
• User name: Enter your KYOCERA Net Manager user name
• Password: Enter your KYOCERA Net Manager password (not PIN, talk to

your KNM Admin if you don’t have a password)
• Select IPP or IPPS

5 Tap the Net Manager slider icon to set to On. You’ll see a Success message
when it connects.

6 Tap Done.

7 Optional – Set printing preferences..

8 Close Printing Preferences.

9 Tap Select queue. You’ll see three tabs, Delegated Printing, Print&Follow,
and Direct queues.

10 Select a queue: tap the queue name (checkmark appears) and then tap Select.

11 Tap Print.

Scanning Documents on iOS devices

1 Open the KYOCERA Mobile Print application.
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2 Select Scan.

3 Tap Select a device at the bottom of the screen.

4 Choose the scanning device to use from the following:

• Favorites
• Recent
• Discover
• Input (IP address or host name)
• Scan QR Code with the mobile device camera

5 Tap a device (checkmark appears) and tap Select.

6 Open Scanning preferences, scroll down, and select Net Manager.

7 Configure KYOCERA Net Manager settings:

• Server - Enter the IP address or hostname of the KYOCERA Net Manager
server

• Port - Enter 9094
• User name: Enter your KYOCERA Net Manager user name
• Password: Enter your KYOCERA Net Manager password (not PIN, talk to

your KNM Admin if you don’t have a password)
• Select IPP or IPPS

8 Tap the Net Manager slider icon to set to On. You’ll see a Success message
when it connects.

9 Tap Done.

10 Optional – Set scanning preferences.

11 Close Scanning preferences.

12 Place document to be scanned on the scanner and tap Scan.

13 Tap Select Destination and pick a location or cloud service for saving your
scan.

14 Tap Save to save your scan to the selected folder or cloud service. Format
choices (in Scanning preferences) are PDF, JPEG and TIFF.
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Embedded Terminal

Printing My Jobs with Embedded Terminal

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap My Jobs on the touch panel.

Note: If you just want to print all jobs queued to your account, tap the Print All
panel button.

3 Tap the row with the jobs you want to print.

4 Tap the Print icon on the touch panel.

After finishing your print job(s), log out (see Logging out of Embedded Terminal
for detail.)

My Jobs panel button

Logout panel button
After My Jobs are printed, they are removed from the Ready folder in the KNM
web UI.

Using Projects with Embedded Terminal and a Print&Follow
Queue

1 Log in to the terminal using the authentication method set by the Admin.

2 Select a printing, copying or scanning option on the panel.

The terminal displays the project window.
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3 Choose a project.

Note: If the Net Manager Admin has enabled printing without a project, you
may select a project, but are not required to do so.

Using Easy Scan with Embedded Terminal

1 Log in to the terminal using the authentication method set by the Admin.

2 Place your document in the document processor or directly on the platen.

3 Tap Easy Scan on the touch panel to start scanning.

Note: There may be two choices for Easy Scan: Email (send the scan to an
email address) and Folder (save the scan to a folder.)

4 If project accounting is enabled on the server, select a project to associate with
the job.

5 After finishing your scan, log out (see Logging Out of Embedded Terminal for
detail.)

Easy Scan - Email panel button
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Logout panel button

Using Easy Copy with Embedded Terminal
Only supported on selected models.

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap Easy Copy on the touch panel.

3 If project accounting is enabled on the server, select a project to associate with
the job and tap Select.

4 After finishing your print jobs, log out (see Logging Out of Embedded Terminal
for detail.)

Easy Copy panel button

Logout panel button

Using Easy Scan Continuous

1 Log in to the terminal using the authentication method set by the Admin.

2 Place your document on the platen.

3 Tap Easy Scan on the touch panel to start scanning.
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Note: Easy Scan may have both Email and Folder option panel buttons.

4 If project accounting is enabled on the server, select a project to associate with
the job.

5 Remove each page from the platen and replace it with the next page in the job.
Tap Next.

6 When the scan job is complete, tap Finish.

7 After finishing your scan, log out (see Logging Out of Embedded Terminal for
detail.)

Easy Scan panel button

Logout panel button

Using Panel Scan with Embedded Terminal
Select Panel Scan to unlock the terminal and manage details of a scan from the
options screen(s).

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap Panel Scan on the touch panel.
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3 If project accounting is enabled on the server, select a project to associate with
the job.

4 After finishing your scan, log out (see Logging Out of Embedded Terminal for
detail.)

Panel Scan panel button

Logout panel button

Using Panel Copy with Embedded Terminal
Select Panel Copy to unlock the terminal and manage details of a copy job from
the options screen(s).

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap Panel Copy on the touch panel.
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3 If project accounting is enabled on the server, select a project to associate with
the job.

4 After finishing your copy, log out (see Logging Out of Embedded Terminal for
detail.)

Panel Copy panel button

Logout panel button

Using Panel Fax with Embedded Terminal
Select Panel Fax to unlock the terminal and manage details of a fax job from the
options screen(s).

1 Log in to the terminal using the authentication method set by the Admin.

2 Place your document in the document processor or directly on the platen.
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3 Tap Panel Fax on the touch panel.

4 After finishing your fax, log out (see Logging Out of Embedded Terminal for
detail.)

Panel Fax panel button

Using Panel USB with Embedded Terminal
Select Panel USB to unlock the terminal and manage removable memory from
the options screen(s). Once a USB drive has been inserted, you can print and
manage files on the drive from the Panel USB screen. You can also scan and
save files to the drive. If you leave the USB panel screen without removing the
drive, you can return by tapping Panel USB again. You can also safely remove
the drive by tapping Remove Memory on the screen.

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap Panel USB on the touch panel.

3 After working with the files on the USB drive, log out (see Logging Out of
Embedded Terminal for detail.)

Panel USB panel button
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Logout panel button

Accessing Applications in Embedded Terminal
Only supported on selected models.

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap Application List on the touch panel to access the menu with available
applications.

3 After finishing your work with applications, log out (see Logging Out of
Embedded Terminal for detail.)

Application List panel button
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About Folders in Embedded Terminal
The embedded terminal panel can only display 10 buttons. If more are needed,
the Admin can create folders and sub-folders to expand the display capability of
the panel, as needed. If you don't see the panel button you're looking for, look in
a folder for more options.

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap the folders button on the touch panel.

Note: The name of the button is assigned by the Admin and may not be as
pictured in the sample below.

3 After working in the folders, log out (see Logging Out of Embedded Terminal for
detail.)

Panel button for sub-folder
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Logout panel button

Deleting Jobs in Embedded Terminal

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap My Jobs on the touch panel.

3 Tap the row with the jobs you want to delete. The selected rows appear in light
gray.

4 Tap Options on the touch panel.

5 Tap Delete (red X) on the touch panel.

6 When you are done, log out (see Logging Out of Embedded Terminal for detail.)

My Jobs panel button
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Logout panel button

The deleted jobs are removed from the Ready folder.

Registering a New ID Card

1 Type your PIN using the keyboard and tap OK on the touch panel.

2 Tap ID Card Registration on the touch panel.

3 Tap the new ID card on the Embedded Terminal card reader. Net Manager will
post a message about the success or failure of the registration.

4 After finishing registering new ID cards, log out (see Logging Out of Embedded
Terminal for detail.)

ID Card Registration panel button
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Logout panel button

Using Credit and a Voucher with Embedded Terminal
You can add credit to your account from the touch panel. When your credit is
too low, a message is posted on the panel and the credit window is displayed so
you can replenish your credit balance before performing or releasing jobs.

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap Recharge Credit on the touch panel.

Note: If you want to see the device's price list, tap Prices... on the Recharge
Credit screen.

3 In the Code box, type your voucher code. If the code is valid, your credit
balance is replenished.

Note: KNM will display either a success or failure message upon entering the
voucher number and tapping OK.

4 After finishing, log out (see Logging Out of Embedded Terminal for detail.)

Recharge Credit panel button
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Logout panel button

Unlocking the Device Panel in Embedded Terminal

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap Unlock Panel on the touch panel.

3 Use the device features as permitted by your access privileges.

4 After finishing your work, log out (see Logging Out of Embedded Terminal for
detail.)

Unlock Panel button
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Logout panel button

Using Job Roaming
Job roaming gives users the ability to print jobs that were saved on a different
site server.

1 Log in to the terminal using the authentication method set by the Admin.

2 Tap My Jobs on the touch panel.

3 Tap the Remote tab. Select print jobs are moved from the remote Net Manager
server to the local Net Manager server.
The Remote tab has an Options menu with buttons for the following actions:

• Delete the job – delete from the local KNM server
• Print the job
• Cancel download – leave jobs on the remote KNM server

4 After finishing your remote session, log out (see Logging Out of Embedded
Terminal for detail.)

My Jobs panel button
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Logout panel button

Using Anonymous Scan and Copy
Anonymous scan and copy supports access to the device features without
authentication by the user. It is available for copying and scanning when the
Lock icon is displayed in the upper right of the touch panel.

1 Tap the Lock icon on the touch panel.

2 You can use the Copy and Scan selections on the touch panel (depending on
admin configuration choices.)

3 After finishing your work, press the Authentication/Logout button on the panel.
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Accessing the Embedded Lite Terminal
For Embedded Lite Terminal login, use the authentication method set up by the
Admin. The panel will be unlocked and all your print jobs waiting in queue will be
printed (model dependant.) After finishing your work, press the
Authentication/Logout button on the touch panel (hard key). Logging out with
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your ID card is not available. You can also allow the terminal to time out and
automatically log you out.
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